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Forces on Point Charges – ID: 9359 
 

Time required 
45 minutes 

 

 

Topic: Electricity and Magnetism  
• Use Coulomb's law to solve problems of force between electric charges. 
• Solve problems involving point charges and force using vector addition. 

Activity Overview 
In this activity, students explore interaction between charged point particles. They first explore 
graphical vector addition and then use vector addition rules to explore the net forces on charged 
particles. The preconstructed templates used in this activity include charged particles, 
represented by points, and forces of interactions between the particles, represented by vectors. 
When students change magnitudes of charges or distances between the particles, the vectors 
representing the forces of interaction change correspondingly. 
 
 

Materials 
To complete this activity, each student will require the following: 

• TI-Nspire™ technology 
• pen or pencil 
• copy of student worksheet 

TI-Nspire Applications 
Graphs & Geometry, Notes 

Teacher Preparation 
Before carrying out this activity, you should review Coulomb’s law with students. Students 
should also be comfortable with the concept of a vector and the rules of vector addition before 
beginning this activity. 

• The screenshots on pages 2–9 demonstrate expected student results. Refer to the 
screenshots on page 10 for a preview of the student TI-Nspire document (.tns file). 

• To download the student worksheet and .tns file, go to education.ti.com/exchange 
and enter “9359” in the search box. 

Classroom Management 
• This activity is designed to be student-centered, with the teacher acting as a facilitator 

while students work cooperatively. The student worksheet guides students through the 
main steps of the activity and includes questions to guide their exploration. Students 
should record their answers to the questions on notebook paper. If time allows, a whole-
class discussion of the activity would be useful for the students. 

• The ideas contained in the following pages are intended to provide a framework as to 
how the activity will progress. Suggestions are also provided to help ensure that the 
objectives for this activity are met. 

• In some cases, these instructions are specific to those students using TI-Nspire 
handheld devices, but the activity can easily be done using TI-Nspire computer software. 
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The following questions will guide student exploration during this activity: 

• How do the positions and charges of particles affect the forces acting on the particles? 
• How can a preconstructed scenario be used to solve electrostatics problems? 

The purpose of this activity is to provide students with an opportunity to explore the interactions 
between charged particles when three or more particles are present in the system. TI-Nspire 
technology provides students with a dynamic environment for explorations and tools for 
graphical and numerical analysis for a variety of situations. 

This activity consists of three parts. The preconstructed templates can also be used by the 
students in and out of class to verify solutions of various problems dealing with point charges 
and forces between them. 

Problem 1 – Graphical vector addition 

Step 1: In this part of the activity, students use TI-
Nspire features to practice graphical methods of 
vector addition. First, students should open the file 
PhysWeek05_PointCharges.tns and read the first 
two pages. They should then proceed to page 1.3, 
which contains an empty Graphs & Geometry page. 
Students should change the page to the Plane 
Geometry view (Menu > View > Plane Geometry 
View) and hide the scale (Menu > View > Hide 
Scale). It is recommended that students change the 
document settings for the angle measurements to be 
in degrees for this activity. To change the document 
settings, students should press /© to enter the 
page sorter view, press b to select the menu, and 
then select Document Settings. 

  

 

Step 2: Next, students use the Vector tool (Menu > 
Points & Lines > Vector) to draw two coterminal 
vectors, AB and AC, on page 1.3.  

Step 3: Next, students should use the Translation 
tool (Menu > Transformations > Translation) to 
translate vector AB to point C. They should label the 
image of point B as D using the Text tool.   
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Step 4: Next, students construct vector AD, the sum 
of AB and AC. They then find the magnitude and 
direction of vector AD using the Length and Slope 
measurement tools from the Measurement menu. 
They should then answer questions 1 and 2. 

Q1. How does the length of vector AD compare with 
the lengths of vectors AB and AC when AB and 
AC are collinear? 

A. When AB and AC are parallel, AD is equal to 
the sum of the lengths of AB and AC. 

Q2. How does the direction (slope) of vector AD 
compare with the slopes of vectors AB and AC? 

A. The slope of AD is partway between the slopes 
of AB and AC. Students can use the Slope 
measurement tool to observe the direction of 
the resultant vector, or they can find the angle 
of the vector to the horizontal. Since the slope 
of the line is equal to the inverse tangent of the 
angle, students can use the Text and Calculate 
tools to find the angle of the resultant vector. 
The instructions for using this method are given 
below: 

• Choose the Text tool (Menu > Actions > 
Text). 

• Click on a blank space anywhere on the 
screen. The text box will open in the edit 
mode. 

• Enter the expression tan-1(s) and press ·. 

• Choose the Calculate tool (Menu > Actions > 
Calculate). 

• Click on the expression. When Select s? 
appears on the screen, move the cursor and 
click on the value of the slope. Press · and 
the value of the slope should appear. Drag the 
expression to the desired location and press 
· again. 

Remind students that, when the angle is in the 
second or third quadrant, they need to add 180º to 
the angle calculated using the inverse tangent. 
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Step 5: Next, students explore the addition of three 
coterminal vectors. They first construct vector AE, 
which should point in a different direction than vector 
AB, AC, or AD. Then, they use the Translation tool to 
add vector AE to vector AD. They label the endpoint 
of this vector F and construct vector AF, which is the 
sum of vectors AB, AC, and AE.  

Step 6: Next, students explore how vector AF 
changes as they move points A, B, C, and E around 
the screen. They should then answer question 3 on 
the student worksheet. 

Q3. Describe the lengths and positions of vectors 
AB, AC, and AE that are required to make AF 
become as small as possible. 

A. There are several combinations of vectors AB, 
AC, and AE that will make vector AF extremely 
small. Encourage students to compare their 
results with one another and discuss the 
different solutions. 

Problem 2 – Interaction between three similarly charged particles  

Next, students should move to page 2.1 and read the 
text there. Page 2.2 shows three positively charged 
particles. The vectors attached to each point show the 
forces on that particle that are produced by the other 
two particles. Students can drag each point and thus 
vary the distances between the particles. The numbers 
on the right-hand side of the screen give the 
magnitudes of the charges on the particles. Students 
can click on these labels and vary the magnitudes of 
the charges. The charges are given in units of 
coulombs (C), and distances are in meters. 

Step 1: Next, students should find the net force on 
each particle using head-to-tail vector addition. They 
should then hide the individual force vectors on the 
particles, so only the net forces are visible, as shown to 
the right.  
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Step 2: Next, students should vary the locations and 
charges of points Q1, Q2, and Q3 and observe the 
results. Then, they should answer questions 4–9 on the 
student worksheet. 

Q4. Describe the changes you observed in the net 
force on each particle when you varied 
magnitudes and positions of the particles. Did 
you notice any patterns? 

A. Due to the open-ended nature of the question, 
many different responses are possible. However, 
students should note that the net forces on the 
particles decreased as the particles got farther 
apart and increased as they got closer together. 
Students should also note that the net forces on 
the particles are directly related to the charges 
on the particles (i.e., the larger the charges, the 
larger the net forces).  

Q5. What happens to the net force on a particle when 
its charge is much larger or smaller than the 
charges on the other two particles? 

A. When the charge on one particle is much larger 
than the charges on the other particles, the net 
forces on all three particles increase significantly. 
As the charge on one particle approaches zero, 
the net force on that particle also approaches 
zero. Note that students may think that the force 
on a particle can never go to zero if the other two 
particles have non-zero charge. Guide them to 
understand that electric forces affect only 
charged particles, so a particle with a zero 
charge will experience no net force.  

Q6. What happens to the net force when one of the 
particles moves very close to one of the other 
particles? 

A. The forces on the particles become very large.  

Q7. What happens to the net force on a particle when 
it is moved far away from the other two particles? 

A. The forces on the particles become very small.  
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Q8. What happens to the net force on a particle when 
it is located exactly between two equally charged 
particles? 

A. The net force on the central particle is zero 
because the vectors acting on the central particle 
have equal magnitudes but opposite directions. 

 

Q9. Three particles, each with a charge of +11 μC, 
are located at the corners of an equilateral 
triangle with sides of length 1 m. Calculate the 
magnitude and direction of the net force on each 
particle. (Hint: Use the template on page 2.2, 
adjust the scale if needed, and reproduce the 
conditions of the problem. Then calculate 
magnitude and angle for each net force.) 

A. Students can use the template on page 2.2 to 
solve this problem graphically. They can place 
the three charges, for example, on the points  

(–1, 0), (0, 0), and (–
1
2

, 
3

2
). They can then 

display the coordinates of points Q1, Q2, and Q3 
using the Coordinates and Equations tool 
(Menu > Actions > Coordinates and 
Equations). They can use the Length and 
Slope measurement tools to determine the 
magnitudes and directions of the resulting forces. 
They should find that the magnitude of the force 
on each particle is 1.9 N and the directions are 
as follows: 

 For (0, 0), θ = –30°; for (–
1
2

, 
3

2
), θ = 90°; and 

for (–1, 0), θ = 210°. Students will probably need 
to adjust the scale of the graph (Menu > 
Window > Window Settings) to see the net 
forces clearly. Students should also calculate the 
magnitudes and directions analytically, using 
Coulomb's law and vector addition rules. 
Coulomb's law yields the net force on each 
particle, as shown on the next page (make sure 
students convert μC to C): 
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 Students can use the law of cosines to determine 
the direction of each vector. 

Problem 3 – Interaction between particles of opposite charge  

In this part of the activity, students explore the 
interactions between positively and negatively charged 
particles. Note that in each template, the sign of the 
charge cannot be changed. Students should read page 
3.1 before moving on to the simulations. (Note: To save 
time, you may construct the net force vectors for this 
problem ahead of time in the .tns file, before 
transferring the file to the students' handhelds or 
computers.) 

Step 1: Students should first move to page 3.2, which 
shows two positively charged particles and one 
negatively charged particle. They should use head-to-
tail vector addition to find the net force on each particle, 
and then hide the individual force vectors on each 
particle so only the net forces are visible. They should 
change the positions and charges of the particles and 
observe the results. 

Step 2: Next, students should move to page 3.3, which 
shows two positively charged particles and two 
negatively charged particles. They should again find the 
net force on each particle and hide the component 
forces. After exploring the effects of position and charge 
on these forces, students should answer questions 10–
14 on the student worksheet. 

Q10. What happens to the net forces when oppositely 
charged particles move very close to one 
another? 

A. The magnitudes of forces on the oppositely 
charged particles increase significantly and 
approach infinity. Their directions become 
opposite. At the same time, the net force on the 
third particle approaches zero. 
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Q11. What happens to the net force on a negatively 
charged particle when it is located exactly 
between two particles of equal positive charge? 

A. When a negatively charged particle is located 
exactly between two equally positively charged 
particles, the net force on the negatively charged 
particle is zero because the two force vectors 
acting on the central particle have equal 
magnitudes but opposite directions. 

Q12. Explore other symmetrical arrangements of the 
particles, and describe any patterns that you 
observe. 

A. Encourage students to explore different 
symmetrical arrangements of particles and 
discuss their results with the class. Encourage 
them to predict the net forces resulting from 
various symmetrical arrangements, and then use 
the templates on pages 3.2 and 3.3 to test their 
predictions.  

Q13. A particle of charge +100 μC is located at (–2, 0), 
and a particle of charge +200 μC is located at (2, 
0). Where should a negatively charged particle 
with charge –50 μC be placed so that the net 
force on this particle has a magnitude of 2 N and 
is directed at –135°? (Hint: You can see the 
coordinates of a point by choosing Menu > 
Actions > Coordinates and Equations and then 
clicking on the point.) 

A. Two possible coordinates are (7, 5.6) and  
(–0.385, 0.082). This particular problem is too 
advanced for analytical solution. It is sufficient if 
students verify their graphical solution by 
calculations. In order to do that, they will need to 
measure the magnitudes and angles of all forces 
and show that the net force in the system is zero. 
Note: If students struggle with this problem, you 
may first ask them to explore a simpler problem, 
such as determining the magnitude and direction 
of the net forces on the particles when they are 
placed at specific locations. 
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Q14. A right isosceles triangle is formed by the 
charges Q1 = +150 μC, Q2 > 0, and Q3 = –120 μC 
located at points (0,10), (0, 0), and (–10, 0), 
respectively. The fourth charge, Q4 = –145 μC, is 
located at the midpoint of the hypotenuse. The 
net force on charge Q4 is 10 N in the positive x-
direction. What is the charge on Q2? 

A. The charge on particle Q2 should be 
approximately +270 μC. Once again, students 
should verify that the net force in the system is 
zero after they find their solution. If you wish, you 
may assign additional problems or explorations to 
student pairs or groups for homework or 
independent projects. 
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Force on Point Charges – ID: 9359 
 (Student)TI-Nspire File: PhysWeek05_PointCharges.tns 
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Name  ____________________________ Forces on Point Charges 

ID: 9359 Class  ____________________________ 
 

 

In this activity, you will 

• explore the effect of charge and distance on 
interaction of three or more charged particles 

• solve problems involving finding net forces of 
interaction between three or more charged particles 

Open the file PhysWeek05_PointCharges.tns on your 
handheld or computer, and follow along with your teacher for 
the first two pages. Move to page 1.2  and wait for further 
instructions from your teacher. 

Remember that Coulomb's law describes the force between 
two point charges, as follows:  

2

qQ
F = k

r
 

In this equation, k is defined as Coulomb's constant 

(
2

9

2

N m
= 9×10  

C

i
k ), q and Q are the magnitudes of the charged 

particles, and r is the distance between the particles.  

In a system of three or more charged particles, each pair of 
particles interacts according to Coulomb’s law. When two or 
more forces act on a particle, all charges and distances affect 
the strength and direction of the force of interaction. In order to 
explore this effect, we need to be able to determine this net 
force of interaction on a given particle due to all charged 
particles. Since forces are vectors, you will need to use vector 
addition rules. 

Problem 1 – Graphical vector addition 

Step 1: Page 1.3 contains a blank Graphs & Geometry page. 
Change the view of this page to Plane Geometry view (Menu > 
View > Plane Geometry View) and hide the scale (Menu > 
View > Hide Scale).  

Step 2: Draw two vectors, AB and AC, using the Vector tool 
(Menu > Points & Lines > Vector). To draw vector AB, first 
select the Vector tool. Then, click once on any point on the 
page. Press gA to label the starting point of the vector A. 
Then, drag the cursor to another point, single-click again, and 
label the ending point of the vector B. To draw vector AC, click 
again on point A and create another vector that points in 
another direction. Label the endpoint of this vector C. 
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Step 3: Next, you will explore the head-to-tail rule of vector 
addition. According to this rule, you can add two vectors by 
placing the head of one vector at the tail of the second. The 
sum of the vectors is then the vector from the tail of the first 
vector to the head of the second vector. To explore this rule 
using vectors AB and AC, you must first translate vector AB so 
that its tail is aligned with the head of vector AC (point C). You 
can use the Translation tool to copy vector AB so that point A 
is aligned with point C. To do this, choose the Translation tool 
(Menu > Transformation > Translation). Click on vector AC 
and then on vector AB and press ·. Vector AB will be 
translated to point C. Draw a point (Menu > Points & Lines > 
Point) at the end of this new vector and label it D.  

Step 4: Use the Vector tool to construct vector AD. Vector AD 
is the sum of vectors AB and AC. Drag point B around the 
screen to observe how vector AD changes as the magnitude 
and direction of vector AB changes. Then, use the Length and 
Slope tools (Menu > Measurement > Length and Menu > 
Measurement > Slope) to measure and label the lengths and 
slopes of vectors AB, AC, and AD. To use the measurement 
tools, first select the appropriate tool from the menu. Then, click 
once on the vector you wish to measure. The measurement will 
appear on the screen. Drag the measurement to where you 
want it to be, and then click again to place the measurement 
there. To label a measurement, double-click on the number, 
and then type the label next to the number. 

Q15. How does the length of vector AD compare with the 
lengths of vectors AB and AC when AB and AC are 
collinear? 

Q16. How does the direction (slope) of vector AD compare 
with the slopes of vectors AB and AC? (Hint: The angle 
of the vector is equal to the inverse tangent of the slope. 
You can use the Text and Calculate tools to calculate 
the angle from the slope measurement you have made.) 

Step 5: Next, you will explore the addition of three vectors. To 
add three vectors, you must first add two of the vectors, and 
then add the third vector to the sum of the other two. Use the 
Vector tool to construct vector AE pointing in a different 
direction than vectors AB, AC, and AD. Adding vector AE to 
vectors AB and AC is equivalent to adding vector AE to vector 
AD. To add these vectors, open the Translation tool. Click on 
vector AD and then on vector AE. Vector AE will then be 
translated to point D. Add a point at the end of this vector, and 
label it F. You can then construct vector AF, the sum of vectors 
AB, AC, and AD.  
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Step 6: Move points A, B, C, and E around the screen, and 
observe how vector AF changes. If you wish, you may hide 
vectors CD, AD, and DF by choosing Menu > Tools > 
Hide/Show and clicking on each vector in turn. This will make it 
easier to see how vector AF is related to vectors AB, AC, and 
AE. 

Q17. Describe the lengths and positions of vectors AB, AC, 
and AE that are required to make AF become as small 
as possible.  

Problem 2 – Interaction between three similarly charged particles 

Page 2.2 shows three charged particles. Because all three 
particles are positively charged, the forces between them are all 
repulsive. The vectors attached to each point show the forces 
on that particle that are produced by the other two particles. 
You can drag each point and thus vary the distances between 
the particles. The numbers on the right-hand side of the screen 
give the magnitudes of the charges on the particles. You can 
click on these labels and vary the magnitudes of the charges. 
The charges are given in units of coulombs (C), and distances 
are in meters. 

Step 1: Find the net force on each particle using head-to-tail 
vector addition. Then, hide the individual forces on each particle 
(the original vectors present on the page).  

Step 2:  Vary the locations and magnitudes of the charges. 
Observe the effects of charge magnitudes and distances 
between the charges on the magnitude and direction of the net 
force on each particle. 

Q18. Describe the changes you observed in the net force on 
each particle when you varied magnitudes and positions 
of the particles. Did you notice any patterns? 

Q19. What happens to the net force on a particle when its 
charge is much larger or smaller than the charges on the 
other two particles? 

Q20. What happens to the net force when one of the particles 
moves very close to one of the other particles? 

Q21. What happens to the net force on a particle when it is 
moved far away from the other two particles? 

Q22. What happens to the net force on a particle when it is 
located exactly between two equally charged particles? 

Q23. Three particles, each with a charge of +11 μC, are 
located at the corners of an equilateral triangle with sides 
of length 1 m. Calculate the magnitude and direction of 
the net force on each particle. (Hint: Use the template on 
page 2.2, adjust the scale if needed, and reproduce the 
conditions of the problem. Then calculate magnitude and 
angle for each net force.) 
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Problem 3 – Interaction between particles of opposite charge 

In this problem, you will explore how interactions between 
oppositely charged particles differ from the interactions 
between particles with the same charge.  

Step 1: Move to page 3.2, which shows two positively charged 
particles and one negatively charged particle. Find the net force 
on each particle using head-to-tail vector addition. Then, hide 
the individual forces on each particle (the original vectors 
present on the page). Move the particles around and observe 
the effects on the resultant forces. 

Step 2: Next, move to page 3.3, which shows two positively 
charged particles and two negatively charged particles. Find 
the net force on each particle using head-to-tail vector addition. 
Then, hide the individual forces on each particle (the original 
vectors present on the page). Move the particles around and 
observe the effects on the resultant forces. 

Q24. What happens to the net forces when oppositely charged particles move very close to one 
another? 

Q25. What happens to the net force on a negatively charged particle when it is located exactly between 
two particles of equal positive charge? 

Q26. Explore other symmetrical arrangements of the particles, and describe any patterns that you 
observe. 

Q27. A particle of charge +100 μC is located at (–2, 0), and a particle of charge +200 μC is located at (2, 
0). Where should a negatively charged particle with charge –50 μC be placed so that the net force 
on this particle has a magnitude of 2 N and is directed at –135°? (Hint: You can see the 
coordinates of a point by choosing Menu > Actions > Coordinates and Equations and then 
clicking on the point.) 

Q28. A right isosceles triangle is formed by the charges Q1 = +150 μC, Q2 > 0, and Q3 = –120 μC 
located at points (0,10), (0, 0), and (–10, 0), respectively. The fourth charge, Q4 = –145 μC, is 
located at the midpoint of the hypotenuse. The net force on charge Q4 is 10 N in the positive x-
direction. What is the charge on Q2? 

  
 

 


